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Consultingwerk Ltd. 

 Independent IT consulting organization 

 Focusing on OpenEdge and .NET 

 Located in Cologne, Germany 

 Vendor of tools and consulting programs 

 22 years of Progress experience (V5 … OE11) 

 GUI for .NET early adaptor (since 10/2006) 

 Recently started with iPhone/iPad development 
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 WinKit 

 SmartComponent Library 

 Dynamics4.NET 
 

 Tools can be used together or separately 

 Share common code base 
 

 SmartComponents.Mobile, 

SmartComponents.Web 

 SmartBPMAdapter for OpenEdge BPM/Savvion 

http://www.consultingwerk.de/ 

OpenEdge® application modernisation solutions 
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 A (short) review of OpenEdge Architect 

 Views and perspectives 

 Some useful keyboard shortcuts 

 (Personal) preferences in OpenEdge Architect 

 Configuring custom file types 

 Run configurations 

 External tools 

 Plugin installation 

 Customizing OpenEdge Architect Templates 

 Open files from ABL code 

 

 

 



OpenEdge Architect 

 Eclipse based, extensible  

 Available since 10.1A (continuously enhanced 

since then) 

 Alternative to the AppBuilder / OpenEdge Studio 

 Requires a separate license (included in PSDN 

SDK), parallel installation possible 

 AppBuilder is integrated 

 Extensible using 3rd party plug-ins (commercial, 

community based) 

 Windows only (Linux support for OE11 dropped) 
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Reasons to migrate to OpenEdge Architect 

 GUI for .NET 

– Visual Designer, Class Browser 

 object-oriented coding 

– no class template in AppBuilder, class browser 

 AppServer Development (10.2B, 11.0) 

 Progress Tools Strategy 

– other development tools also Eclipse based 

(i.e. Sonic MQ, Sonic ESB, Savvion, 

OpenEdge BPM, …) 
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OpenEdge Architect 

 Eclipse is a Java Application 

 Progress has created plugins for OpenEdge 

specific functionality 

 Features (collection of plugins) and branding 

 Progress compiler executed in prowin32.exe 

(AVM) or _progres.exe (for TTY code) 

 Communication between Java and AVM via 

Network sockets 

 ADE legacy tools (Data Dictionary) available via 

integrated AVM 
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What is OpenEdge Architect 

 

 

 

Navigate and 
Edit 

Database 
Schema 

Create New 
and Edit 
Existing 

ABL code 

Design 
ProDataSets 
Graphically 

Design UI 
Compile 

ABL code 

Debug and 
Run ABL 

code 

Extend 
development 
environment 

easily 



Demo of integrated features 

 Class Browser 

 Visual Designer 

 Search & Replace 

 Integrated Debugger (set break point) 

 ABL online help (turn it into a fast view) 

 Open Resource Dialog (CTRL-SHIFT-R) 

 Outline / Quick Outline Dialog (CTRL-O) 

 Hyperlink opening of files (include file, RUN, 

class reference) 
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Default „OpenEdge Editor“ perspective  

Default Views: Resources, Outline, DB Structure, Properties, 

Console, Problems, Tasks 
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Views 

 Views support the developer by navigating to 

code, reviewing status information, access to 

IDE or plug-in functionality, … 

 Views can be opened an closed 

 Window – Show View Dialog 

 Views can be grouped together as tabs 

 The views area can be split as needed 

 Views or groups of views can be dragged out of 

the main workbench window 
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Elements of a View 
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Caption 

 

Toolbar Buttons 

 

Context Menu(s) 

 

 

 

 

 

 

 

 

View Content 



Fast view 

 Views that temporarily overlap the workbench 

window 

 Accessed from a button in the workbench status 

area 

 „Closed“ when loosing focus, just click 

somewhere else – don‘t „X“ them  

 Each view can become a „fast view“ 

 Useful for reference style views: Class browser, 

online help, … 
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Demo 

 Rearranging Views 

 Class browser as fast view 

 Making the ABL help a fast view 
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Perspectives 

 Stored layout of views 

 Organizing the workbench for different tasks: 

– Coding 

– Visual Designer / AppBuilder 

– Debugging 

– MyLyn planning 

 Window – Open Perspective Dialog 
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Perspectives 
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Open Perspective 

Dialog 

List of currently opened 

perspectives, allows  

quick switching 
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A selection of keyboard shortcuts 

 Ctrl-Shift-R: Open Resource 

 Ctrl-O: Quick Outline in code editor 

 Ctrl dot: Toggle between errors in code editor 

 Ctrl-Shift-C: Check syntax 

 Ctrl-S:Safe 

 Ctrl-3: Open view, menu item, editor, … (almost 

everything) 

 Alt-Shift-P, Alt-Shift-F: New procedure, function 

 Alt-Shift-M, Alt-Shift-Y: New method, new prop. 
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Ctrl-Shift-L 

 Lists even more 

shortcuts 

 Not all may be 

relevant to 

OpenEdge Architect 
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Workspace preferences in OEA 

 Main menu-bar, Window -> Preferences 
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Workspace preferences in OEA 

 General – Editors – Text Editors 

– Insert spaces for Tabs, Tab width, show line 

numbers, … 

 General – Search  

– Reuse editors … turned off 

 OpenEdge Architect – Editor 

– As you type: Case (upper or lower), case 

keywords, depending on your style: expand 

keywords 
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Workspace preferences in OEA 

 General – Workspace 

– Refresh automatically (on fast machines, local 

source code) 

 

 Refreshing causes Eclipse to search the file 

system for new, deleted, modified files 

 Sync‘s Eclipses view of the world 

 Files not in sync will be skipped on compile, 

search, etc… 

 Alternative is manual refresh (e.g. F5 key) 
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Workspace preferences in OEA 

 OpenEdge Architect – Editor – Build 

– Auto check syntax  (while typing) 

– Maximum number of errors reported per build: 

much higher than 100 (e.g. 100,000) when 

you have 

• templates or scratch files 

• migration routines that typically never 

compile 

• just never cleaned up source source code 

(Copy of test.p, test_backup.p) 
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Workspace preferences in OEA 

 OpenEdge Architect – Editor – Templates 

– Fix MES Template (Message statement) 

– mfe Template 
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Link with Editor (Resource view) 

 Keeps resource view  

(file browser) and current 

editor in sync when  

switching editor tabs 
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Error filters 

 Use error filters dialog to configure filters 

– default (show all) usually not helpful on large 

projects 

– my preference is ‘selected element and its 

children‘ 

– or use working sets  
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Configuring custom file types 

 Purpose of configuring custom file types 

– Defining the editor choices and defaults 

– Color coded source code editor for custom file 

extensions (.f include files etc.) 

– Configuring complilable file types 

– Include file tracking, hyperlink navigation 
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Open Edge Builder Properties 
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add custom 

include  

file extension 



Content type definition 

 Add extension to „OpenEdge ABL Source Files“ 

content types to enable color coding 
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File Associations 

 Add associated 

editors 

 Define default  

editor for file type 

Customizing OpenEdge Architect 34 



Sample custom file type .f (Form include) 

 Syntax color coding and syntax check 

 Double click in resources view to open ABL code 

 Include file icon in resources tree 
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Run configurations 

 Create a default “Run Configuration” by running 

a .p, .cls, .w from the run button 

 Can be customized using Run Configurations 

Dialog 

 Defaults to project settings 

 Typically starts new AVM for each run 
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Run configurations 

 Define how ABL code is executed 

 Database connections 

 Propath definition 

 Startup parameters 

 Graphical dialog 

 Log file setting 

 Progress version 

 TTY/GUI 

Customizing OpenEdge Architect 38 



Review Run configation 

 Open “Run Configurations“ Dialog 
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Review Run configation 
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Shared File 

 A Shared File may be used to distribute Run Config 

to team members (.launch file checked in to SCM) 
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Using Run configuration 

 Testing with different DB‘s, or no DB at all 

 Changing client logfile settings 

 

 Prefer to start new OpenEdge AVM (not use the 

project AVM for your own launches) 
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External Tools configuration 

 Similar to Run Configuration but for OS 

commands, scripts, executables 

 Command may receive parameters from Eclipse 

(selected file, folder etc.) 

 Build possible before launch 

 Refresh possible after launch 

 Console output may be captured  

by Eclipse 

 

 Poor man‘s Eclipse plugin 
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Portable through the use of variables 

 Location of workspace resources, projects, files, 

… variable 

 Reuse in multiple  

projects 
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Demo: External Tools configuration 

 Integrating AutoDox2 (from Joanju) 

 Remove R-Code batch file 
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Eclipse Plugins 

 Java classes following Eclipse specs 

 Typically provide additional functionality to the 

IDE 

 Plugins may provide additional functionality to 

other plugins  

 Plugins may have dependencies to other 

Plugins 

 Plugin installation using Eclipse wizards or copy 

of Java binaries and further files 
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Typical Eclipse Plugins 

 Eclipse community projects 

– Mylyn, Bug tracking integration, Task focussed 

UI, time tracking 

 Commercial vendors 

– Tugboat, Roundtable TSMS, Roundtable Team 

– Perforce 

 Open source Community  

– NTail 

– Grep console 
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Eclipse Plugin Installation 

 … follow instructions of the Plugin vendor 

 

 Help -> Software Updates 

 Help -> Classic Software Updates -> Find an 

Install 

 

 Installation from “Update sites” 

 Eclipse community project update sites typically 

already known to the workbench 
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Eclipse Plugins Demonstration 

 Examples of Eclipse Plugins and their 

installation 

– Mylyn 
• http://www.eclipse.org/mylyn/ 

– Perforce SCM (Team Provider) 
• http://www.perforce.com/product/components/eclipse_plugin 

– Grep Console 
• http://marian.musgit.com/projects_grepconsole.php 
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Customizing Templates made easy 

 OpenEdge Architect Author name for new files 

defaults to OS-login (e.g. Administrator) 

 Use vmargs –Duser.name Startup parameter to 

override this 
 http://blog.consultingwerk.de/consultingwerkblog/2011/08/customizi

ng-openedge-architect-templates-made-easy-personalization/ 

C:\Progress\OpenEdge102B\oeide\eclips

e\eclipse.exe -showlocation -vm 

“C:\Progress\OpenEdge102B\jre\bin\jav

aw.exe” -vmargs -Duser.name=”Mike 

Fechner / Consultingwerk Ltd.” 
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Customizing Templates made easy 
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Customizing Templates using JET 

 Overriding existing templates for new files, e.g. 

modifying the file header comment  

 Overriding existing templates for new code 

blocks, e.g. new internal procedure wizard, new 

method, new property 

 Additional new file templates 

– Currently only supported for .p file extension 

(functional limitation) 

– Might be relaxed in 11.1 
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Customizing Templates 

 http://communities.progress.com/pcom/docs/DO

C-16387 

 Documentation a bit outdated (10.1B) 

 Works with 10.2B and OE11 with a little 

tweaking and creativity   

 Use existing templates as a starting point, create 

copies of files in DLC\oeide\eclipse\plugins\ 

com.openedge.pdt.text_version\templates 
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Customizing Templates 

 Eclipse templates based on JET: Java Emitter 

Template 

 Plugin installation required: Java Development 

Tools (JDT) and Eclipse Modeling Framework 

(EMF) 

 Use version appropriate for your OpenEdge 

Architect installation … (Eclipse version used) 

 JDT and EMF Plugins only required for the 

developer that creates templates, not those 

using them 
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Eclipse Plugins 

 Eclipse Plugins for my 10.2B06 installation 
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Java Build Path 

 Java Build Path from documentation needs 

additional .jar file in 10.2B/11.0 
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OpenEdge Architect Templates 
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Template generation sequence 

 Sequence executed whenever 

source file is modified 
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JET Template + 

generator.skeleton 

(Java source code) 

Java Source code 

.java file 

Compiled Java 

Class file 

.class file  

Register in 

Customization 

Editor 



Demo 

 Template customization environment 

 Customized method template 

 Customized new class template 

 Review Java functions 

 Review code in JET Template that checks for 

class properties 
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Opening files from ABL code 

 Eclipse (Java) and ABL runtime separate 

processes 

 Communication via network protocol 

– Java to AVM (compile command) 

– AVM to Java (certain UI operations) 

 ABL code may us OS-GETENV („OEA_PORT“) 

to determine the network port 
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Opening files form ABL code 

 Public API‘s defined in  

adecomm/oeideservice.i 

 Supports querying basic project properties, 

opening views for ABL windows (like OEUnit 

does) and opening files  

 getProjectName () 

 openEditor () 
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Sample Open Debug Listing 

 

Customizing OpenEdge Architect 67 

Function prototype defined 

in oeideservice.i 



Sample Open Debug Listing 
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_idestartup.p 

 Optional ABL procedure file (create it when 

needed) 

 Will be executed once when Project AVM is 

started 

 May be used to initialize developers Framework 

code, when required for Visual Designer or 

AppBuilder, etc. 
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More info… 

 Getting started videos 

http://communities.progress.com/pcom/docs/DO

C-101140 

 Top OpenEdge Architect FAQ, Sunil Belgaonkar 

http://communities.progress.com/pcom/communi

ty/psdn/exchange/trackprod6 

 Consultingwerk blog – openedge-architect tag 

http://blog.consultingwerk.de/consultingwerkblog

/tag/openedge-architect/ 
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Questions ? 
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Thank you! 


